**Tutorial: Solving a Conjugate Heat Transfer Problem using ANSYS FLUENT**

**Introduction**

The physics of conjugate heat transfer is common in many engineering applications, including heat exchangers, HVAC, and electronic component design. The purpose of this tutorial is to provide guidelines and recommendations for setting up and solving a conjugate heat transfer problem using ANSYS FLUENT.

The geometry and flow domain consists of a flat circuit board with a heat generating electronic chip mounted on it. Heat is conducted through the source (chip) and the board on which it is mounted. A laminar stream of air flows over the board and the chip, causing simultaneous cooling of the solid components and heating of the air stream due to convection. Thermal energy is also transported due to the complex flow field.

This tutorial demonstrates how to do the following:

- Set up appropriate boundary conditions for a conjugate heat transfer simulation in ANSYS FLUENT.
- Enable source terms for specified zones.
- Perform flow and energy calculations using various materials (both solid and fluid).
- Manipulate mesh adaption registers and perform Boolean operations on them.
- Perform mesh adaption and verify that the solution is mesh independent.

**Prerequisites**

This tutorial assumes that you are familiar with the ANSYS FLUENT interface and that you have a good understanding of the basic setup and solution procedures. Some steps will not be shown explicitly.

You will perform postprocessing related only to mesh adaption and verification of a mesh independent solution. For detailed postprocessing of this simulation, refer to the ANSYS FLUENT 14 Tutorial Guide.

© ANSYS, Inc. March 7, 2012
Problem Description

The problem considered is shown schematically in Figure 1. The configuration consists of a series of heat-generating electronic chips mounted on a circuit board. Air flow, confined between the circuit board and an upper wall, cools the chips and the board. As the air flows over the chips and the board, its temperature rises. Taking the symmetry of the configuration into consideration, the model extends from the middle of one chip to the plane of symmetry between it and the next chip.

As shown in Figure 1, each half chip is assumed to generate 1 Watt and have a thermal conductivity of 1.0 W/m-K. The circuit board conductivity is assumed to be one order of magnitude lower, at 0.1 W/m-K. Air enters the system at 298 K with a velocity of 0.5 m/s. The inlet Reynolds number (based on the spacing between the upper and lower walls) is approximately 870 and thus, the flow is treated as laminar.

Figure 1: Problem Schematic

Setup and Solution

Preparation

1. Copy the mesh file, chip3d.msh.gz to your working folder.

2. Use FLUENT Launcher to start the 3D version of ANSYS FLUENT.

   For more information about FLUENT Launcher refer to Section 1.1.2, Starting ANSYS FLUENT Using FLUENT Launcher in ANSYS FLUENT 14.0 User’s Guide.
Setup and Solution

Step 1: Mesh

1. Read the mesh file (chip3d.msh.gz).

As the mesh file is read, ANSYS FLUENT reports the progress in the console.

Step 2: General Settings

1. Retain the default solver settings.

2. Scale the mesh.

   (a) Select the Mesh Was Created In drop-down list.
   (b) Select the View Length Unit In drop-down list.
   (c) Close the Scale Mesh dialog box.

3. Check the mesh.

   ANSYS FLUENT will perform various checks on the mesh and report the progress in the console. Make sure the minimum volume reported is a positive number.

Figure 2: Mesh Display
Step 3: Models

1. Enable the Energy Equation.

   ![Image](models_energy_edit.png)

2. Ensure laminar viscous model is selected.

   ![Image](models_viscous_edit.png)

Step 4: Materials

![Image](materials_create_edit.png)

The working fluid is air. You need to specify the materials for the chip and the board. These materials are assumed to have the same density and heat capacity as that of aluminum, but different thermal conductivities.

1. Model air as an incompressible ideal gas.

   For this simulation, model air as an incompressible gas because there is a maximum air temperature rise of about 150°C, but very little pressure change. The incompressible ideal gas option for density treats the fluid density only as a function of temperature.

   (a) Select fluid from the Material Type drop-down list.
   (b) Select incompressible-ideal-gas from the Density drop-down list.
   (c) Click Change/Create.

2. Create the chip material.

   (a) Select solid from the Material Type drop-down list.
   (b) Enter chip for Name and delete the entry for Chemical Formula.
   (c) Enter 1.0 for Thermal Conductivity.
   (d) Click Change/Create.

   ANSYS FLUENT displays a question dialog asking whether to overwrite aluminum. Click No.

3. Create the board material.

   (a) Enter board for Name and delete the entry for Chemical Formula.
   (b) Enter 0.1 for Thermal Conductivity.
   (c) Click Change/Create.

   Do not overwrite aluminum.

Step 5: Cell Zone Conditions

1. Specify the cell zone condition for cont-fluid-air zone.
   - Ensure that fluid is selected from the Type drop-down list.
   - Click Edit... to open the Fluid dialog box.
     i. Ensure that air is selected from the Material Name drop-down list.
     ii. Click OK to close the Fluid dialog box.

2. Specify the cell zone condition for cont-solid-board zone.
   - Ensure that solid is selected from the Type drop-down list.
   - Click Edit... to open the Solid dialog box.
     i. Select board from the Material Name drop-down list.
     ii. Click OK to close the Solid dialog box.

3. Specify the cell zone condition for cont-solid-chip zone.
(a) Ensure that **solid** is selected from the **Type** drop-down list.

(b) Click **Edit...** to open the **Solid** dialog box.

   i. Select **chip** from the **Material Name** drop-down list.

   ii. Enable **Source Terms**.

   iii. Click the **Source Terms** tab and click the **Edit...** button to open the **Energy (w/m3) sources** dialog box.

A. Set the **Number of Energy (w/m3) sources** to 1.

B. Select **constant** from the drop-down list and enter 904055.
C. Click OK to close the Energy(w/m3) sources dialog box.

This value, based on the half-volume of the chip, yields a total energy source of 2 Watts in the chip zone.

iv. Click OK to close the Solid dialog box.

Step 6: Boundary Conditions

1. Define the inflow and outflow boundaries.
   (a) Set the boundary conditions for the inlet zone.

   ![Boundary Conditions] (inlet) Edit...

   i. Enter 0.5 m/s for Velocity Magnitude.
   ii. Click the Thermal tab and enter 298 K for Temperature.
   iii. Click OK to close the Velocity Inlet dialog box.

   (b) Set the boundary conditions for the outlet zone.

   ![Boundary Conditions] (outlet) Edit...

   i. Retain 0 for Gauge Pressure.
   ii. Click the Thermal tab and enter 298 K for Backflow Total Temperature.
   iii. Click OK to close the Pressure Outlet dialog box.

2. Define the thermal boundary conditions.
   (a) Ensure that the Coupled thermal condition is selected for the following walls:
      - wall-chip and wall-chip-shadow
      - wall-chip-bottom and wall-chip-bottom-shadow
      - wall-duct-bottom and wall-duct-bottom-shadow

3. Set the boundary conditions for the wall-board-bottom zone.

   ![Boundary Conditions] (wall-board-bottom) Edit...

   (a) Click the Thermal tab select Convection from the Thermal Conditions list.
   (b) Enter 1.5 for Heat Transfer Coefficient.
   (c) Enter 298 for Free Stream Temperature.
   (d) Click OK to close the Wall dialog box.

4. Copy the boundary conditions set for the wall-board-bottom zone to the wall-duct-top zone.

   ![Boundary Conditions] Copy...

   (a) Select wall-board-bottom from the From Boundary Zone selection list.
   (b) Select all zones from the To Boundary Zones selection list.
(c) Click Copy.

A Question dialog box is displayed asking if you want to copy wall-board-bottom boundary conditions to all the selected zones. Click OK.

(d) Close the Copy Conditions dialog box.

Verify that the boundary conditions were copied correctly. Copying a boundary condition does not create a link from one zone to another. If you want to change boundary conditions on these zones, you will have to change each one separately.

Step 7: Solution

1. Define the solution method parameters.

   Solution Methods

   (a) Select Green-Gauss Node Based from the Gradient drop-down list.

   (b) Ensure that Second Order Upwind is selected from the Momentum and Energy drop-down lists.

2. Retain the default under relaxation factors.
3. Ensure the plotting of residuals during the calculation.

(a) Enter 0.0001 for continuity.
(b) Click OK to close the Residual Monitors dialog box.

4. Define a point monitor for the energy equation.

You will define a point monitor in the recirculation region behind the chip. The solution convergence is critical in this region.

(a) Enter 2.85, 0.25, and 0.3 for Coordinates x0, y0, and z0.
(b) Enter point-monitor for New Surface Name.
(c) Click Create and close the Point Surface dialog box.

5. Enable the plotting of the point monitor.

(a) Enable Plot and Write for surf-mon-1.
(b) Select Vertex Average from the Report Type drop-down list.
(c) Select Temperature... and Static Temperature from the Field Variable drop-down lists.
(d) Select point-monitor from the Surfaces selection list.
(e) Click OK to close the Surface Monitor dialog box.

6. Save the case file chip3d.cas.gz.

7. Initialize the solution.
Solving a Conjugate Heat Transfer Problem using ANSYS FLUENT

(a) Select Standard Initialization from the Initialization Methods group box.
(b) Select inlet from the Compute From drop-down list.
(c) Click Initialize.

8. Request 200 iterations (Figures 3 and 4).

Run Calculation — Calculate

The solution converges in approximately 145 iterations.

Figure 3: Residual Plot

Figure 4: Convergence History of Static Temperature at Monitor Point
Step 8: Data Analysis

1. Verify that mass is conserved.

(a) Ensure Mass Flow Rate is selected from the Options list.
(b) Select inlet and outlet from the Boundaries selection list.
(c) Click Compute.

ANSYS FLUENT displays the total mass flux across each boundary selected.

- The mass flow rate for the inlet should be positive (indicating that mass is entering the domain), while that for the outlet should be negative (indicating that mass is leaving the domain).
- The net mass flux appears in the box at the lower right corner of the Flux Reports dialog box.
- The net mass flux (inlet plus outlet) should be almost zero, indicating that mass is conserved.

2. Verify that energy is conserved.

(a) Select Total Heat Transfer Rate from the Options list.
(b) Deselect the previously selected boundaries (inlet and outlet) from the Boundaries selection list and select wall-chip and wall-chip-bottom.
(c) Click Compute.

The net heat transfer from the chip should 1 Watt since only half the chip is modeled.
(d) Select surfaces where heat flows into and/or out of the computational domain.

(e) Retain the selection of wall-chip and wall-chip-bottom from the Boundaries selection list.

(f) Select the convection boundaries, wall-duct-top and wall-board-bottom, and inlet and outlet.

   The selection of the inlet and outlet surfaces accounts for the heat carried by the air as it enters and leaves the domain.

(g) Click the Compute button.

   The net heat transfer error should be very small, indicating that an overall heat balance has been achieved. It should be less than 1% of the smallest source.

3. Close the Flux Reports dialog box.

**Step 9: Postprocessing**

You will perform postprocessing related to mesh adaption and verification of a mesh independent solution.

1. Set up line surfaces for plotting.

   Surface — Line/Rake...
Solving a Conjugate Heat Transfer Problem using ANSYS FLUENT

1. Create line surfaces line-xwss and line-cross with end points as follows:

<table>
<thead>
<tr>
<th>Line</th>
<th>x0 (m)</th>
<th>y0 (m)</th>
<th>z0 (m)</th>
<th>x1 (m)</th>
<th>y1 (m)</th>
<th>z1 (m)</th>
</tr>
</thead>
<tbody>
<tr>
<td>line-xwss</td>
<td>2.75</td>
<td>0.1001</td>
<td>0</td>
<td>4.75</td>
<td>0.1001</td>
<td>0</td>
</tr>
<tr>
<td>line-cross</td>
<td>3.5</td>
<td>0.25</td>
<td>0</td>
<td>3.5</td>
<td>0.25</td>
<td>0.5</td>
</tr>
</tbody>
</table>

(b) Close the Line/Rake Surface dialog box.

2. Generate an XY plot of the cross-stream temperature profile downstream of the chip along the line surface, line-cross.

(a) Ensure that Node Values and Position on X Axis are enabled from the Options list.

(b) Enter 0, 0 and, 1 for X, Y and, Z respectively in the Plot Direction group box.

(c) Select Temperature... and Static Temperature from the Y Axis Function drop-down lists.

(d) Select line-cross from the Surfaces selection list.

(e) Click Plot (Figure 5).

Figure 5 shows the predicted cross stream temperature profile behind the block. The effects of the heated block are apparent. The mesh is currently too coarse to resolve the heat transfer details accurately.

(f) Enable Write to File from the Options list and click Write... to open the Select File dialog box.

(g) Enter temp-0.xy for XY File and click OK.

3. Generate an XY plot of the cross-stream velocity profile downstream of the chip along the line surface line-cross.
Figure 5: Cross-Stream Static Temperature Profile at x = 3.5 in, y = 0.25 in

(a) Disable Write to File.
(b) Select Velocity... and Velocity Magnitude in the Y Axis Function drop-down lists.
(c) Ensure line-cross is selected from the Surfaces selection list and click Plot (Figure 6).

Figure 6: Cross-Stream Velocity Magnitude Profile at x = 3.5 in, y = 0.25 in
Figure 6 shows the predicted cross stream velocity profile behind the block. Flow details are smeared due to the relatively coarse mesh used. The mesh is currently too coarse to resolve the flow details accurately.

(d) Write the data to an output file velocity-0.xy.

4. Generate an XY plot of the stream-wise component of wall shear stress in the stream-wise direction along the center of the chip.

(a) Disable Node Values and Write to File.
(b) Ensure Position on X Axis is enabled from the Options list.
(c) Enter 1, 0 and, 0 for X, Y and, Z respectively in the Plot Direction group box.
(d) Select Wall Fluxes... and X-Wall Shear Stress in the Y Axis Function drop-down lists.
(e) Select line-xwss from the Surfaces selection list and click Plot (Figure 7).
(f) Write the data to an output file xwss-0.xy.
(g) Close the Solution XY Plot dialog box.

![Figure 7: X-Wall Shear Stress Profile Downstream of the Chip](image)

5. Save the case and data files (chip3d.cas.gz and chip3d.dat.gz).

Step 10: Mesh Adaption

The solution can be improved by refining the mesh to better resolve the flow details. It is also important to verify if the flow solution is independent of the mesh size used.
Solving a Conjugate Heat Transfer Problem using ANSYS FLUENT

1. Create mesh adaption registers based on gradients of pressure, velocity, and temperature, as well as a region adaption register. An adaption register is a logical collection of cells that have been marked for adaption.

2. Combine the adaption registers using Boolean addition and adapt the mesh using the combination register.

3. Continue with the iterations, examine the results obtained using refined mesh.

4. Determine if the solution is mesh independent or if further adaption is required. Mesh adaption should always be performed until mesh independence is achieved.

1. Create a pressure gradient adaption register.

   (a) Retain the default selection of Curvature from the Method list.
   (b) Select Pressure... and Static Pressure in the Gradients of drop-down lists.
   (c) Click Compute.

   ANSYS FLUENT reports that the maximum adaption function value is approximately 0.000176.

   (d) Enter 1.76e-5 for Refine Threshold.

   Coarsen Threshold specifies the threshold values for coarsening the grid. Cells with adaption function values (in this case, pressure gradient) below the Coarsen Threshold will be marked for coarsening. Refine Threshold specifies the threshold values for refining the grid. Cells with adaption function values above the Refine Threshold will be marked for refining.

   When selecting values for Refine Threshold, a good rule of thumb is to use approximately 10% of the value reported in the Max field (i.e., the maximum value of the adaption function).

   For more information on adaption, refer to Chapter 30. Adapting the Mesh the ANSYS FLUENT 14.0 User’s Guide.

   (e) Click Mark.

   ANSYS FLUENT creates a pressure gradient adaption register. ANSYS FLUENT reports that approximately 152 cells were marked for refinement. Additional cells might have been marked because of the requirements of adaptional algorithms.

   (f) View the cells marked for pressure gradient adaption (Figure 8).

      i. Click the Manage... button to open the Manage Adaption Registers dialog box.
      ii. Select gradient-r0 from the Registers selection list.
      iii. Click Display.

      You can modify the display of the adaption register by setting the respective options in the Adaption Display Options dialog box. You can open this dialog
Solving a Conjugate Heat Transfer Problem using ANSYS FLUENT

Figure 8: Cells Marked (approx. 152) for Pressure Gradient Adaption

box by clicking the Options... button in the Manage Adaption Registers dialog box.

Figure 8 shows the cells marked for pressure gradient adaption. These cells are concentrated on the front face of the block, where the static pressure is changing abruptly due to stagnation and change in the direction of the air flow.

2. Create a velocity gradient adaption register.
   (a) Select Velocity... and Velocity Magnitude from the Gradients of drop-down lists.
   (b) Click Compute.
   ANSYS FLUENT reports that the maximum adaption function value is approximately 0.00057.
   (c) Enter a value of 5.7e-5 for Refine Threshold (10% of the maximum value).
   (d) Click Mark.
   ANSYS FLUENT creates a velocity gradient adaption register. The ANSYS FLUENT console window reports that approximately 1543 cells were marked for refinement.
   (e) View the cells marked for velocity gradient adaption (Figure 9).

3. Create a temperature gradient adaption register.
   (a) Select Temperature... and Static Temperature from the Gradients of drop-down lists.
   (b) Click Compute.
   ANSYS FLUENT reports that the maximum adaption function value is approximately 0.0976.
Solving a Conjugate Heat Transfer Problem using ANSYS FLUENT

Figure 9: Cells Marked (approx. 1543) for Velocity Gradient Adaption

(c) Enter a value of 0.00978 for Refine Threshold (10% of the maximum value).

(d) Click Mark.

ANSYS FLUENT creates a temperature gradient adaption register. The ANSYS FLUENT console window reports that approximately 380 cells were marked for refinement.

(e) View the cells marked for temperature gradient adaption (Figure 10).

Figure 10 shows the cells marked for temperature gradient adaption. These cells are concentrated mainly near the block (where the temperature is changing rapidly).

4. Create a region adaption register.

Adapt→Region...

The Region Adaption dialog box is displayed.

(a) Enter the Input Coordinates as follows to select the region for adaption.

<table>
<thead>
<tr>
<th></th>
<th>Min (in)</th>
<th>Max (in)</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>2.75</td>
<td>5.0</td>
</tr>
<tr>
<td>Y</td>
<td>0.1</td>
<td>0.4</td>
</tr>
<tr>
<td>Z</td>
<td>0</td>
<td>0.5</td>
</tr>
</tbody>
</table>

(b) Click Mark.

ANSYS FLUENT reports that approximately 1454 cells were marked for refinement in the console window.

(c) View the cells marked for region adaption.
Solving a Conjugate Heat Transfer Problem using ANSYS FLUENT

Figure 10: Cells (approx. 383) Marked for Temperature Gradient Adaption

Figure 11: Cells (approx. 1454) Marked for Region Adaption
Figure 11 shows the cells marked for region adaption. Region adaption allows you to specify a bounding box that is used to select cells for adaption. In this case, the cells behind the block are selected for refinement.

5. Perform a Boolean addition of the pressure gradient, velocity gradient, temperature gradient, and region adaption registers.

   (a) Select the registers gradient-r0, gradient-r1, gradient-r2, and hexahedron-r3 from the Registers selection list in the Manage Adaption Registers dialog box.

   (b) Click the Combine button.

   A fifth register (combination-r4) is created. This register represents the Boolean addition of the pressure gradient, velocity gradient, temperature gradient, and region adaption registers. The ANSYS FLUENT console window reports that a total of approximately 3104 cells are marked as a result of combining the four adaption criteria.

   (c) View the cells marked for adaption.

Figure 12: Combination of Pressure Gradient, Velocity Gradient, Temperature Gradient, and Region Adaption Registers (approx. 3104 Cells Marked)

Figure 12 shows the cells marked for mesh adaption. It is a combination of pressure gradient, velocity gradient, temperature gradient, and region adaption registers for region adaption

6. Adapt the mesh using the combination register, combination-r4.

   (a) Select combination-r4 from the Registers selection list in the Manage Adaption Registers dialog box.

   (b) Click Adapt.

   A Question dialog box appears asking whether to change the mesh. Click Yes.
7. Close the Region Adaption, Manage Adaption Registers, and Gradient Adaption dialog boxes.

Step 11: Solution

1. Request an additional 400 iterations. (Figures 13 and 14).

   ![Run Calculation](https://via.placeholder.com/150)

   The solution converges in 340 additional iterations.

   ![Figure 13: Residual Plot After First Mesh Adaption](https://via.placeholder.com/150)

   ![Figure 14: Convergence History of Static Temperature at Monitor Point After First Mesh Adaption](https://via.placeholder.com/150)
Solving a Conjugate Heat Transfer Problem using ANSYS FLUENT

2. Save the case and data files (chip3d-adapt1.cas.gz and chip3d-adapt1.dat.gz).

File ➔ Write ➔ Case & Data...

Step 12: Postprocessing

In this step, you will determine whether the solution is independent of the mesh, or if further mesh adaption is required. This is determined by comparing the predicted profiles of temperature, velocity, and wall shear stress for the refined mesh with those obtained for a relatively coarse mesh. Hence, you can evaluate how sensitive the solution is, with respect to changes in mesh size.

1. Compare the temperature profiles obtained for the original and the adapted meshes.

   (a) Enable Node Values and Position on X Axis from the Options list.
   (b) Disable Write to File.
   (c) Enter 0, 0 and, 1 for X, Y and, Z respectively in the Plot Direction group box.
   (d) Select Temperature... and Static Temperature from the Y Axis Function drop-down lists.
   (e) Select line-cross from the Surfaces selection list.
   (f) Load the file, temp-0.xy.
      i. Click the Load File... button to open the Select File dialog box.
      ii. Select temp-0.xy and click OK.
   (g) Select Static Temperature from the File Data selection list.
   (h) Click Plot (Figure 15).

   Figure 15 indicates that the temperature distribution has changed considerably after adapting the mesh. This is because the original mesh was too coarse to resolve temperature gradients and thus, predict accurate heat transfer. Based on this comparison, you can conclude that the solution is dependent on the mesh and that a further mesh adaption should be performed.

2. Compare the velocity profiles obtained for the original and the adapted meshes.

   (a) Select Velocity... and Velocity Magnitude from the Y Axis Function drop-down lists.
   (b) Load the file, velocity-0.xy.
   (c) Select Velocity Magnitude from the File Data selection lists.

   Deselect the previous selections from the File Data selection list.
   (d) Click Plot (Figure 16).

   Figure 16 indicates that the velocity distribution appears to be approaching mesh independence. However, based on the comparison of temperature profiles, you need perform another adaption.
Solving a Conjugate Heat Transfer Problem using ANSYS FLUENT

Figure 15: Comparison of Temperature Profiles After First Mesh Adaption

Figure 16: Comparison of Velocity Magnitude Profiles After First Mesh Adaption
3. Compare the wall shear stress profiles obtained for the original and the adapted meshes.

(a) Disable Node Values from the Options list.

(b) Enter 1, 0 and, 0 for X, Y and, Z respectively in the Plot Direction group box.

(c) Select Wall Fluxes... and X-Wall Shear Stress from the Y Axis Function drop-down lists.

(d) Select line-xwss from the Surfaces selection list.

(e) Load the file, xwss-0.xy.

(f) Select X-Wall Shear Stress from the File Data selection list. selection list.

   Ensure to deselect any previous selections under File Data.

(g) Click Plot (Figure 17).

(h) Close the Solution XY Plot dialog box.

![Figure 17: Comparison of X-Wall Shear Stress Profiles After First Mesh Adaption](image)

Figure 17 indicates that the wall shear stress distribution is essentially mesh independent. However, based on the comparison of temperature profiles you need to perform another mesh adaption.

**Step 13: Further Mesh Adaption and Postprocessing**

For most cases, one or two mesh adaptions are sufficient to obtain a mesh independent solution. So far, you performed one adaption in an attempt to improve the solution and migrate toward a solution that is independent of the mesh. However, another adaption should be performed to investigate if considerable changes are seen in the solution (as seen in Figure 15) after mesh refinement.
When performing successive mesh adaptations, the adaption threshold values should not be changed. If they are changed (usually the tendency is to reduce them), the solution accuracy will not meet the criteria set forth by specifying the threshold values.

The second level of mesh adaption is not shown explicitly. The results are presented and are briefly discussed.

- Figure 18 shows the cells marked for the second pressure gradient adaption.

![Figure 18: Cells Marked (approx. 428) for Second Pressure Gradient Adaption](image)

- Figure 19 shows the cells marked for the second velocity gradient adaption.

![Figure 19: Cells Marked (approx. 6575) for Second Velocity Gradient Adaption](image)
• Figure 20 shows the cells marked for the second temperature gradient adaption.

Figure 20: Cells Marked (approx. 1104) for Second Temperature Gradient Adaption

• Figure 21 shows the cells marked for the second region adaption.

Figure 21: Cells Marked (approx. 11305) for Second Region Adaption
• Figure 22 shows the cells marked for the second mesh adaption (combination of pressure gradient, velocity gradient, temperature gradient, and region adaption registers).

Figure 22: Cells Marked (approx. 18404) for Second Mesh Adaption

• Figures 23 and 24 show the residual plot and convergence history of temperature at the monitor point respectively.

Figure 23: Residual Plot After Second Mesh Adaption
Solving a Conjugate Heat Transfer Problem using ANSYS FLUENT

Figure 24: Convergence History of Static Temperature at Monitor Point After Second Mesh Adaption

- Figure 25 shows the predicted cross-stream temperature profiles for the three mesh refinement levels. As the mesh is made successively finer, the predicted profile approaches a shape that is independent of the mesh.

Figure 25: Comparison of Temperature Profiles After Two Mesh Adapations
• Figure 26 shows the predicted velocity profiles for the three mesh refinement levels. The velocity profile approaches a shape that is independent of the mesh.

![Velocity Profile Graph]

Figure 26: Comparison of Velocity Profiles After Two Mesh Adaptions

• Figure 27 shows the predicted wall shear stress profiles for the three mesh refinement levels. The wall shear stress exhibits mesh independence upon successive mesh refinement.

![Wall Shear Stress Graph]

Figure 27: Comparison of X-Wall Shear Stress Profiles After Two Mesh Adaptions
Further Improvement

You have performed two mesh adaptions to improve the solution and obtain a mesh independent solution. If required, you can perform this mesh adaptation. When performing successive mesh adaptions, do not change the adaption threshold values, when the solution starts converging (with respect to the mesh). If they are changed (usually the tendency is to reduce them), the solution accuracy will not meet the criteria set forth by specifying the threshold values. For a given threshold value, we would like to adapt until no cells are marked, i.e. the solution is considered to be grid-independent.

Note: There are different threshold values for each variable you are adapting on.

Summary

This tutorial demonstrated the simulation of laminar flow around an electric component (chip) using ANSYS FLUENT. The heat generated by the chip is simulated by enabling the source term. Conjugate heat transfer was investigated in the form of the heating of air as it flows around the chip, conduction in the chip itself, and conduction/convection in the board. You performed two levels of solution-based mesh adaption (based on gradients of pressure, velocity, and temperature). After the second adaption, the solution was considered as mesh independent.